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ChatGPT 4 в Телеграм - самая последняя модель! На русском, 5000 токенов бесплатно 🙂 →
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В чем отличие C++ от других языков

C++ используют в финтехе, разработке игр, для создания программ разной сложности: от простых утилит до масштабных систем. C++ сложно назвать языком для новичков, в простоте он уступает популярному Python. Однако у C++ есть особенности, которые делают его более гибким.

Большие возможности и большая ответственность. Многие современные языки, такие как C#, Java, Ruby обеспечивают управление памятью и проверки безопасности без участия программиста, на уровне компилятора. Но Страуструп считает это не преимуществом, а уязвимостью, от которой страдает и безопасность, и быстродействие. В C++ все контролирует автор программы.

Объектно-ориентированность. Концепция ООП была реализована еще в Simula67. Но по-настоящему популярным подход стал благодаря работам Страуструпа.

Универсальность и гибкость. C++ разрабатывался как язык для широкого круга задач, от программирования микроконтроллеров до систем любой сложности. Страуструп предполагал, что для разработки потребуются многочисленные библиотеки с нужными классами и функциями. 

Frequently Asked Questions

What Is The Best C++ IDE?

Although it is difficult to choose the right IDE, some of the most popular IDEs include Visual Studio, Code::Blocks, CLion and Eclipse CDT. Most developers use multiple IDEs, so doing your research to find the benefits of each one helps you find the best C++ IDE for you.

What Is The Best C++ IDE For Mac?

Multiple C++ IDEs work for Mac Books. Such as CodeLite, Xcode, and GNAT programming studio, which are part of Incredibuild’s 12 best C++ IDEs for 2023. Read about each one to find the best IDE for you.

What Is The Best C++ IDE For Windows?

Some of our favorite C++ IDEs for windows include DEV C++, GNAT programming studio, and CodeLite. Read about each in this guide to the best C++ IDEs for 2023 to find the best one for you.
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Dori Exterman

An expert software developer and product strategist, Dori Exterman has 20 years of experience in the software development industry. As CTO of Incredibuild, he directs the company’s product strategy and is responsible for product vision, implementation, and technical partnerships. Before joining Incredibuild, Dori held a variety of technical and product development roles at software companies, with a focus on architecture, performance, advanced technologies, DevOps, release management and C++. He is an expert and frequent speaker on technological advancement in development tools.

3) CLion
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Clion — это мощная и кроссплатформенная IDE для C и C++ от компании JetBrains, которая включает в себя современные стандарты C ++, libc ++ и Boost. Эта IDE хорошо знает коды и упрощает рутину, позволяя сосредотачиваться на основных вещах разработки. Одной из его основных возможностей является рефакторинг, который позволяет вам переименовывать символы, сдвигать элементы вверх или вниз по ранжированию, изменять сигнатуру функции, а также гарантировать, что ее автоматический рефакторинг будет правильно генерировать необходимые изменения в коде.

Видео курсы по схожей тематике:
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STL – стандартная библиотека шаблонов. Теория и практика


Павленко Александр
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C++ Стартовый


Владимир Виноградов
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C++ Базовый


Кирилл Чернега

Интегрированный отладчик анализирует и решает проблемы с помощью дружественного пользовательского интерфейса IDE с GDB / LLDB в качестве бэкэнда. Более того, он также удаленно связывается с нативными процессами или отладками.

Особенности IDE Clion:

	Только платные версии IDE.
	Поддерживаемые языки C и C++.
	Доступны версии под Linux, Windows, macOS.


Плюсы IDE Clion:

	Удобные инструменты для разработки визуальных интерфейсов.
	Удобные механизмы отладки приложений.
	Возможности расширения функционала плагинами.
	Инструменты поиска ошибок в коде в потоковом режиме.


Минусы IDE Clion:

	Отсутствует бесплатная версия этой IDE.
	Годовая подписка от 199$.


CodeLite

CodeLite is another free and open-source IDE. It supports C/C++, PHP, and JavaScript and is built with the wxWidgets cross-platform toolkit, allowing it to run on Windows, macOS, Linux, and FreeBSD. The editor is based on the open-source Scintilla project.

CodeLite provides a simple but comprehensive user interface and includes support for project management, refactoring, code completion, syntax highlighting, debugging via GNU’s gdb, and integration with source code management systems like Git and Subversion.

The IDE also includes a wxWidgets creation tool that allows developers to design cross-platform graphical user interfaces easily.

Visual Studio

Visual Studio is the most popular choice for good reasons: this mature tool is cross-platform, supports many programming languages, and is packed with an incredible array of features. Visual Studio’s code compilation technology (named IntelliSense) is widely praised and relied on daily by many developers. It has excellent syntax highlighting, an easy-to-use UI designer, CMake support, and a powerful debugger and profiler system. In addition, it has a huge community so there’s no shortage of know-hows, samples and more.

What functionality Microsoft doesn’t include is often provided by an impressive collection of available Visual Studio extensions. Developers will enjoy a wide selection of extensions for C++.

Fun Fact: Incredibuid is bundled inside Visual Studio to accelerate C++ builds.

Простейшая программа

Откройте редактор, создайте файл и перепишите следующий текст:
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Это — минимальная программа на языке C++. Она выводит в терминал строку “Hello, world!” и завершается. Она состоит из:

	директива подключит библиотеку потоков ввода-вывода, в том числе станут доступны поток вывода std::cout и манипулятор std::endl.
	функция служит точкой входа в программу в тот момент, когда операционная система запускает программу
	в функции сейчас находится ровно одна инструкция, которая передаёт строку в поток вывода cout и затем передаёт туда же манипулятор endl (сокращение от end line), чтобы добавить перенос строки и завершить операцию вывода cout


Сохраните файл — это можно сделать в меню “File” либо горячей клавишей :
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Затем откройте терминал. В Visual Studio Code терминал можно открыть в меню “Вид”>”Интегрированный терминал” либо сочетанием клавиш “CTRL + `”
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Введите в терминале команду . Команда выведет список файлов, и среди этих файлов должен быть файл .

Введите команду . Программа — это компилятор C++ из состава GCC (GNU Compiler Collections). Передав ей флаг , вы заставите программу вывести свою версию и завершиться. Ожидается, что у вас будет g++ 7.0 или выше:

Введите команду . Эта команда компилирует файл hello.cpp в исполняемую программу называет исполняемый файл на платформе Windows либо на Linux и MacOSX. Команда не должна выводить чего-либо, она должна просто успешно завершиться.
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Теперь вы можете запустить исполняемую программу , набрав в терминале команду .

Задание cpp1.1

Убедитесь, что у вас есть файл , в котором записана работоспособная программа “Hello, World”. Доработайте программу, чтобы вместо “Hello, World” она выводила “Hello, Name”, где Name — ваше имя в английской транскрипции.

Настраиваем внешний вид редактора

Итак, мы уже установили VS Code и несколько расширений. Теперь мы готовы настраивать среду разработки. Я создал шаблон для спортивного программирования в VS Code и загрузил его в свой профиль на Github.

Перейдите по этой ссылке и загрузите шаблон себе на компьютер. Распакуйте его в любое место по вашему выбору. После этого откройте получившуюся папку в VS Code. Вы должны увидеть что-то вроде этого:

Пройдитесь по файлам main.cpp, Main.java и main.py и посмотрите на записанный в них образец кода. По сути, шаблонный код, предоставленный в образцах для каждого из этих трех языков, принимает входящие данные из файла input.txt и обеспечивает вывод в файл output.txt. Для каждой программистской задачи, которую вы хотите решить, просто создайте копию этого шаблона и напишите свой код в функции solve().

Теперь создадим ту разбивку экрана, которую вы могли видеть на самом первом изображении в этой статье. Эта разбивка позволяет сразу видеть как ввод, так и вывод вашего кода, что делает ее очень удобной в использовании.

	Откройте файлы в следующем порядке: main.cpp, input.txt, output.txt. Порядок, в каком были открыты файлы, можно видеть сверху на панели инструментов. Убедитесь, что порядок именно такой, как указано выше.
	Откройте input.txt. Выберите в меню View -> Editor Layout -> Split Right. Вы должны увидеть что-то подобное:


У вас получится две группы. Перетащите output.txt из левой группы в правую. Закройте тот input.txt, что остался слева. Должно выйти примерно так:

Далее откройте output.txt в правой группе. Выберите View -> Editor Layout -> Split Down. Уберите output.txt из верхней группы. После этого вы увидите:

Готово! Мы настроили внешний вид редактора. А теперь давайте запускать код.

SharpDevelop IDE

SharpDevelop — это IDE с открытым исходным кодом для проектов на платформе Microsoft .NET. В SharpDevelop возможно программирование на языках C #, VB.NET, F #, IronPython и IronRuby, а также целевые и расширенные возможности: Windows Forms или WPF, а также ASP.NET MVC и WCF.

 Может запускаться с USB-накопителя, поставляется с интегрированными инструментальными средствами и инструментами для тестирования производительности, Git, NuGet. Имеет множество функций, которые повышают производительность труда разработчика. Это IDE с открытым исходным кодом, можно свободно скачать исходный код и исполняемые файлы c сайта загрузки. SharpDevelop имеет мощный интегрированный отладчик, включая динамические функции отладки, предоставляет возможность модульного тестирования и анализа кода.


	Поддерживаемые языки программирования
	C # (Windows Forms Designer) 
	VB.NET (Windows Forms Designer) 
	Boo (Windows Forms Designer) 
	IronPython (Windows Forms Designer) 
	IronRuby (Windows Forms Designer) 
	F# 



	Каркасы приложений, Frameworks
	Windows Presentation Foundation (WPF) 
	Windows Forms 
	ASP.NET MVC 
	Entity Framework (EF EDM Designer) 



	 Производительность труда разработчиков
	Функция завершения кода подобная IntelliSense
	Рефакторинг (пакетное переименование, улучшение структуры кода) 
	Параллельная поддержка сборки для многоядерных машин
	 Поддержка пакетов NuGet и T4 
	Автоматическая вставка кода
	Запуск с карты памяти USB
	поддержка чтения проект (Подробнее) 
	Полная поддержка MSBuild (платформа сборки проекта) 



	 Инструменты
	Встроенный отладчик (в том числе динамические особенности отладки) 
	Анализ кода 
	Модульное тестирование (NUnit) 
	Встроенная поддержка Git 





Написание

Начало программ и их составление – это изучение выбранного ЯП. Когда с синтаксисом пользователь уже разобрался, можно приступать к активным действиям. Ранее указанные инструменты устанавливают на задействованное устройство. Лишь после этого система будет готова к первым проектам.


Для VS



Чтобы программировать на C++ в Visual Studio, потребуется выполнить следующие действия:

	Для начала запустить среду разработки.
	Выбрать «Файл»-«Создать»-«Проект».
	Переключиться в категорию «Общие».
	Щелкнуть по надписи «Пустой…».
	Придумать название. Пример – Lesson1.
	Подтвердить действие.


На экране появится проект. В нем предстоит осуществлять дальнейшие действия. Если часть кода уже имеется на устройстве, можно загрузить ее и продолжить написание.

В обозревателе решений остается кликнуть ПКМ на папке «файлы исходного кода». Там – выбрать «Добавить»-«Создать элемент». Нужно сделать новый документ main.cpp и добавить его в разработку.


Для GCC



В случае с GCC действовать предстоит иначе. Пользователю необходимо создать пустой файл. Далее – открыть через любой текстовый редактор с подсветкой синтаксиса.


Код-пример



В самом начале рассмотрения C++ не нужно проектировать сложный контент. Вот пример кода, который будет реализовываться новичками:
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Именно эту запись предстоит вставить в текстовый редактор или VS. При компиляции она образует самостоятельную утилиту.


Синтаксис



C++ обладает непростым синтаксисом. Он предусматривает множество нюансов и особенностей. Вот объяснение того, как функционирует программа, написанная выше:

	Директива #include отвечает за подключение других файлов в исполняемый код. Если там написано <iostream> — происходит замена строчки на документ iostream.h. Это – стандартная библиотека языка. Отвечает за ввод и вывод.
	#include <csrdlib> — еще одна стандартная библиотека. Она нужна для функционирования system.
	Using namespace std – указание на то, что клиент изначально будет использовать пространство имен с названием std. Все, написанное после int main() будет автоматически выполняться после запуска ПО.
	Count << «Hello, world!» << end; — запись, которая отвечает за вывод на экран надписи в кавычках.


В первой программе на C++ обычно изучают процесс вывода информации на экран. Count – основной оператор, который предстоит использовать. Текст, который хочется вывести на дисплей из командной строки, прописывается в двойных кавычках. End1 отвечает за перевод строчки уровнем ниже.

При завершении работы утилиты без сбоев происходит генерация кода ошибки, равного нулю. Return 0 требуется для передачи сообщения о том, что софт успешно обработан.


Запуск



Для того, чтобы у начинающих не возникло проблем с запуском первой программы на C++, требуется разобраться, как это сделать. В Visual Studio для этого можно задействовать сочетания Ctrl + F5. В GCC – выполнить такие команды:
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Если код написан грамотно, он выведет на экран окно с приложением. В противном случае возникнет сообщение об ошибке.
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Отличия между IDE и текстовым редактором

Для начала напомним разницу между текстовым редактором, применяемым для написания программ и полноценной IDE. Если упростить, текстовый редактор – это программа, с помощью которой разработчик взаимодействует непосредственно с кодом как текстом. Используя клавиатуру, с помощью текстового редактора разработчик вводит символы и ключевые слова языка программирования, описывая этими словами некий алгоритм, понятный в дальнейшем компьютеру. Код, написанный на C++ с помощью текстового редактора кода, нужно будет в дальнейшем отправить на компилирование в другую программу – компилятор, который не входит в состав текстового редактора.

Интегрированная среда разработки, в свою очередь, это некий комплекс отдельных инструментов разработчика, позволяющий не только написать код программы, но и скомпилировать этот код в готовое приложение, провести тестирование этой программы, поиск ошибок, рефакторинг и другие действия. В состав современных IDE, как отдельные элементы уже входят:

	текстовый редактор;
	компилятор (или интерпретатор – для интерпретируемых языков программирования);
	отладчик;
	система управления версиями;
	другие инструменты.


Современные IDE могут существенно расширять свой функционал благодаря различным плагинам. Стоит отметить, что некоторые текстовые редакторы (например Vim, Visual Studio Code, Emacs), благодаря доступным плагинам, также расширяют свой функционал, доводя его до практически IDEшных возможностей. Однако, это все же два разных инструмента разработчика. Текстовый редактор предназначен скорее для внесения мелких изменений в код отдельных файлов будущей программы. IDE, в свою очередь, работает с программой комплексно, рассматривая ее в целом как «проект» или набор «проектов», а не как отдельные текстовые файлы с кодом. Отсюда и разница в доступных возможностях этих инструментов.

1) Visual Studio
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Visual Studio занимает первое место в нашем рейтинге. Это широко известная полнофункциональная среда разработки от компании Microsoft, которая позволяет работать с такими платформами, как Windows, Интернет, облако и Android. Возможности IDE Visual Studio позволяют правильно и эффективно писать код, реорганизовывать, анализировать и исправлять проблемы с кодом. Система IntelliSense предсказывает API-интерфейсы по мере их написания и выполняет автоматическое завершение для повышения скорости и эффективности разработки.

Именно эта IDE позволяет новичку легче всего войти в процесс разработки.

Особенности Visual Studio:

	Свой компилятор – MSVC.
	Существуют версии, работающие на macOS и Windows.
	Поддерживает такие языки: ASP.NET, Ajax, DHTML, Visual C++, JavaScript, JScript, Visual Basic, Visual C#, Visual F#, XAML и др.


Плюсы IDE Visual Studio:

	Бесплатно распространяется Visual Studio Community, с достаточным набором возможностей.
	Платные версии могут предоставляться учебным заведениям и студентам бесплатно.
	Удобная система умного автодополнения.
	Большое количество настроек среды разработки под «себя», благодаря встроенным механизмам и доступным дополнениям.


Минусы IDE Visual Studio:

	Версии Visual Studio Professional и Visual Studio Enterprise являются платными.
	Тяжеловесная IDE, достаточно требовательная к железу.
	Ряд разработчиков считают ее избыточной для создания мелких проектов.
	Достаточно маленькая скорость запуска проектов и приложений.
	Не работает на Linux.
	Платные версии с расширенным функционалом распространяются по подписке: Professional – от 45$ в месяц, Enterprise – от 250$ в месяц.


Create a Hello World App

To make sure the compiler is installed and configured correctly, lets create a Hello World C++ program.

Create a C++ file

	On Windows, launch a Windows command prompt (Enter Windows command prompt in the Windows search bar). On macOS and Linux, you can enter these commands in the terminal.
	Run the following commands. They are creating an empty folder called where you can place all your VS Code projects. The next commands create and navigate you to a subfolder called . From there, you are opening directly in VS Code using the command.


The «code .» command opens VS Code in the current working folder, which becomes your «workspace». Accept the Workspace Trust dialog by selecting Yes, I trust the authors since this is a folder you created.

	
[image: 3.2. среды разработки (ide)]



	
[image: С++ | первая программа в visual studio]

	
[image: The 11 best c++ ides (and code editors) for 2024]

	
[image: The 12 best c++ ides of 2023 - incredibuild]

	
[image: Программирование. компиляторы и ide для языка си]

	
[image: 15 лучших бесплатных ide c++ (редактор и компилятор) для windows (2024)]

	
[image: How to install c and c++ compilers on windows]

	
[image: Ms visual c++ (2015-2022) runtime — скачать для windows]

	
[image: Создание первого приложения на c++ otus]

	
[image: Interestprograms.ru]

Now create a new file called with the New File button in the File Explorer or File > New File command.

[image: alt]

Add Hello World source code

Paste in the following source code:

Now press ⌘S (Windows, Linux Ctrl+S) to save the file. You can also enable to automatically save your file changes, by checking Auto Save in the main File menu.

Install the GCC and G++ Compilers

Click the start button. Find the MSYS2 64bit folder. Click on that folder to expand it.
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If you are using a 64 bit operating system like I am, then we need to use the MSYS2 MinGW x64 terminal. Click on the terminal to open that.
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️ But, if you are using a 32 bit operating system, then you have to use the MSYS2 MinGW x86 terminal. Then, you need to open that terminal.
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As I am using a 64 bit operating system, I have opened the terminal for 64 bit. Apply the command to install the compilers.

️ If you are using a 32 bit operating system, then you have to apply the command in your 32 bit terminal.
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Wait for a little while.
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Type or and press the enter key if you get the installation prompts.
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Give it some time to finish the installation process.
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You’ve now finished installing the compilers.

Первая программа в Visual Studio


Последнее обновление: 07.02.2023

Для создания программы на C++ нам нужны, как минимум, две вещи: текстовый редактор для набора кода и компилятор для превращения этого кода в приложение.

При этом для компиляции необходимо запускать консоль или терминал. Однако есть и более удобный способ — использование различных сред разработки или IDE.

Они, как правило, содержит встроенный текстовый редактор, компилятор и позволяют скомпилировать и запустить программу по одному клику мыши,

а также имеют еще множество разных вспомогательных возможностей.

После загрузки и запуска установщика Visual Studio в нем необходимо отметить пункт Разработка классических приложений на C++:

Выбрав все необходимые пункты, нажмем ОК для запуска установки. После установки Visual Studio создадим первый проект. Для этого откроем

Visual Studio. На стартовом экране среди шаблонов проектов для языка C++ выберем тип Console App, который представляет шаблон консольного приложения:

На следующем экране в поле для имени проекта дадим проекту имя HelloApp и также можно указать расположение проекта. И затем нажмем на Create для создания проекта.

После этого Visual Studio создаст типовой проект консольного приложения на C++.

Справа в окне Solution Explorer отображается структура проекта. В реальности окно Solution Explorer содержит в решение.

В данном случае оно называется HelloApp. Решение может содержать несколько проектов. По умолчанию у нас один проект, который имеет то же имя — HelloApp. В проекте есть ряд узлов:

	
External Dependencies: отображает файлы, которые используются в файлах исходного кода, но не являются частью проекта


	
Header Files: предназначена для хранения заголовочных файлов с расширением .h


	
Resource Files: предназначена для хранения файлов ресурсов, например, изображений


	
Source Files: хранит файлы с исходным кодом




По умолчанию каталог Source Files содержит один файл с исходным кодом — HelloApp.cpp

( + расширение файла — как правило, исходные файлы на C++ имеют расширение ).

HelloApp.cpp содержит код на языке C++, и именно этот код мы можем увидеть в слева в текстовом редакторе Visual Studio.

По умолчанию HelloApp.cpp содержит следующий код:


#include <iostream>        			// подключение модуля iostream

int main()									// определяем функцию main
{											// начало функции
	std::cout << "Hello World!\n";	// выводим строку на консоль
}		


Здесь использован весь тот код, который был рассмотрен в начальных темах.

Теперь запустим программу. Для этого в Visual Studio нажмем на сочетание клавиш Ctrl+F5 или выберем пункт меню Debug -> Start Without Debugging:

И в итоге Visual Studio передаст исходный код компилятору, который скомпилирует из кода исполняемый файл exe, который потом будет запущен на выполнение.

И мы увидим на запущенной консоли наше сообщение:

После этого на жестком диске в папке решения в каталоге \x64\Debug скомпилированный файл exe, который мы можем запускать независимо от Visual Studio:

В данном случае файл HelloApp.exe как раз и представляет скомпилированный исполняемый файл.

И, кроме того, в той же папке автоматически генерируется вспомогательный файл — HelloApp.pdb, который содержит отладочную информацию.
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Настройка проекта

Для языка C++ есть несколько стандартов, каждый из которых добавляет некоторые дополнительные возможности. И Visual Studio позволяет задать стандарт, который будет использоваться

при компиляции приложения. Для этого перейдем к свойствам проекта:

А в окне свойств перейдем к пункту Configuration Properties -> C/C++ -> Language.

На открывшемся окне свойств с помощью опции C++ Language Standard можно задать стандарт языка, который мы хотим использовать:

НазадВперед

Turbo C++

Borland Turbo C++ was one of the first IDEs developed for C++ back in 1990. It was later discontinued and the developer stopped providing any updates. The first initial release was released for MS-DOS. The successor of this IDE is C++ Builder who is still alive and is receiving updates. However, it is the opposite for Turbo C++.

The most unique identifier of this IDE was the C++ templates that it offered. This helped programmers save a lot of time as they did not have to make them from scratch.

It is popular among educational institutes to teach students the C++ language as it is free and can also be downloaded for Android.

It is now supported by a developer named “NeuTroN”.

Вывод

Существует достаточно большое количество интегрированных сред разработки на C++. Для выбора IDE под разработку на C++, как и для любого другого инструмента разработчика, справедлив индивидуальный подход. Отталкиваясь от текущих задач, базовой ОС, используемых языков, необходимых плагинов, требований команды и других, сугубо индивидуальных факторов разработки, выбор вами лучшей среды программирования C++ будет различным.

Мы рекомендуем выбирать среду разработки из нашего ТОП 7. Если же вы хотите конкретный совет для начинающего – под Windows попробуйте начать разрабатывать с Visual Studio в бесплатной версии Community. В качестве лучшей бесплатной среды разработки C++под Linux попробуйте Code::Blocks и NetBeans. Упоминая выбор лучшей платной среды разработки C++ для Linux и macOS, в свою очередь, мы рекомендуем попробовать триальную версию платной IDE – CLion.  

В любом случае, если вы планируете разрабатывать на C++ в течение длительного времени, выбор главного инструмента вряд ли будет для вас окончательным. Пробуйте разные варианты и следите за новшествами и изменениями.

Начинающим разработчикам на C++ мы рекомендуем ознакомиться с видео курсами ITVDN:

Ввод-вывод

Теперь напишем программу, которая читает два числа из стандартного ввода и пишет их обратно в стандартный вывод. Эта программа будет использовать функции языка C: и .

Создайте файл и напечатайте в нём следующий код:

Скомпилируйте код командой . Запустите, и введите

	два целых числа:

	одно целое число и одно число с плавающей точкой:

	одно целое число и одну букву f:

	только букву f:

	ничего не вводить, сразу нажать “Ctrl+Z” на Windows или “Ctrl+D” на остальных платформах, что означает “конец ввода”


Если что-то пошло неправильно, вы можете нажать в терминале для завершения программы.

Мы прокомментировали код, чтобы вы поняли, что происходит. В языке C++ однострочные комментарии начинаются с символов . Комментарии помогают понять текст программы, и поэтому хороший комментарий поясняет намерение там, где оно не очевидно из кода. Плохие комментарии поясняют очевидные вещи: писать такое — бесполезный труд. В то же время хороший комментарий может уберечь программиста от неосторожных и неправильных действий.

Теперь доработаем программу

Кайфани от технологий - задай любые вопросы ChatGPT4 в Телеграм! На русском языке, 5000 токенов бесплатно 🙂 →
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